The MIDAS Touch

Part 1

The ingenuity behind this unigue application of the VWA

The volume-weighted average price can be applied o

davtrading and shart-term swing trading. Here's how
by Andrew Coles, Phi}

a Technical Analysiz of STOCKS & COMMODI-
TiES article published in May 2001 Cleorge

- Revna drew ottention to how a cerfain type of
I volume-weighted nverage price (VWAFP) cal-
e culation can be a powerful predictor of suppor

andl resistance nssocinted with major reversals off the dmly

churts. This |s a technigue that would be of inicrest to the

posit jom trader
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principle can only be appreciated in the context of standird
Viwap caleulations, which have been extensively applied in
A standard VWAP calcu-
lation represents the total value of shares tradid ina particular

the trading industry for many ycars.

stock on o given day divided by the totul volume of shures
iraded in that stock on that sume day. This standard caleula-
tion is thus & method of pricing transactions and is typically
used as 4 benchmark to measure the efficiency of institutional
trading or the performance of traders themselves

As an example, in the mutual and pension funds industry
it is used as o trading benchmark: the point of using a YWAP
trading target is to ensure that the truder executing the order
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does so in line with the market volume, This way, transaction
costs are reduced by minimizing murket impact,

An extension of this idea is known as “guarinteed VWAP
execution,” whereby a broker may guarantee execution of an
order at the VWA in order 1o earn the trader’s commission,
As a means of evalunting trading performanie, this standard
calculation would figure in positive or negative appraisals
being given to a long trade lower than or above its daily
VWAP, respectively, and vice versa for short trades. A spe-
cific illustration is supplied by trader Kevin Haggerty in an
interview he gave 10 S&C in 1999, In conjunction with other
price und yolume considerations, Haggerty ex amines whether
1 stock price has closed above its daily VWAP.

However, the aim of Reyna' s study was to show how a new
type of VWAP calculation created by the late Paul Levine,
who was a physicist as well as a technical analyst, can be usid
to create nonlinear support and resistance curves predictive
of major trend reversals. The present study extends this topic
fiot only by exploring Levine’s VWAP approach to technical
analysis more deeply. but also, and most imporiant, by
applying the same VWAP technology 1o intraday charts and
daytrading.

Paul, LEVINE™S PHILOSOPHY

When Levine was developing the VWAP support and resis-
tance indicator, he ealled it “MIDAS,” as both o play on the
King Midas myth and an scronym for “market interpretation/
data annlysis system,”

At the heart of MiDas s a philosophy of technical analysis
that is unigquely Levine's. While we do nat have the space here
to explore every aspect of this approach, we shall be looking
the most important ideas. Although Levine’s philosophy was
developed while he was studying the daily charts with longer-
term price movements of interest to the position wrader/longer-
term swing trader, it is equally valid when applied to very
short-lerm intraday time frames. In a nushell, Levine's phi-
losophy can be reduced 1o five basic lenets:

1 Superficiglly, murkets appear disordered. but there is
an underlying order that cannot be visually accessed
by the majority of technical analysis iools. This order
— i complex fractal hierarchy of support and resis-
tunce levels — is the fundamental reality underlying
market price behavior.

2 This fundamental reality, the interplay between sup-
port and resistance, is in foct & coaction between
it Lo anil dintribnfinn

3 This trading psychology coaction can be considered
quantitatively from raw price and volume data and
reveals o mathematical symmetry between support

The ingenuity behind this application of
the VWAP principle can only be
appreciated in the context of standard
VWAP calculations.

i INDICATORS I |

and resistance. This phenomenon is properly scien-
tific: the quantitative charaeterization in MIDAS al- ‘
lows us to see what the apparenily random patterns of

stock prices actually consist of. ‘

4 Murkets can be predicted to a very large degree by
using this single algorithmic procedure, which is
symmetrical in the sense that the same formula |
upplies in the prediction of murket tops and bottoms,

5 To accomplish this, it is essential to focus on price |
and volume data subseguenrtoareversul intrendand |
thus o a major change in sentiment, Price-derived
instruments such us moving averages may omit these |
crucial periods of new psychology and neglect the ‘
critical importance of volume. By contrast, the MIDAS
algorithm locates the real underlying order of mar-
kets — the fractally ordered hierarchical levels of
support and resistance — at the volume-weighted
average price taken over an interval subscquent fo @
reversal in trend.

These philosophical principles have been derived lurgely
from a series of 18 tersely written articles that Levine pub- ‘
lished online in 1995, Levine referred to the quantitative lnws
that give rise to the support/resistance hierarchies as the
scientific component of MiDas. He called the engineening
aspect the practical trading rules and techniques bused on the
system. Before coming to some of them—and expanding our
understanding of MIDAS in the context of daytrading — we
need 1o be introduced to the formulu itself’, |

'ne MIDAS FORMULA ‘
The particulir Vwap formula used by Paul Levine was fully
discussed in George Reyna’s anticle. The mathematical detail |
of the conceptual foundations we have just examined can be
expressed as the following equation: ‘

MiDAs = ) =% = dy)]
, TP d

where: ‘

«, =Cumulative volume on day

v, = Cumulative price on doy

d, =Cumulative volume difference between days i and j

=x-K |

This equation reads: (The cumulative price)(Volume at a
v bwssntd M bt potas MU ATnwen ot o pawindd of |
units of cumulative volume earlier), all divided by o, where
o is the cumulative volume displacement measured from the
launch point to the given instant.

However, of eritical importance is the luunch point of the
system. As we saw in the fifth tener, this point must be
precisely where there is o clear reversal in trend. Itis criveal
not to use periods before this because they mix periods of
differing underlying psychology and thus contuminale new |
shifts in accumulation or distribution,
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FIGURE 1; DAILY CHART OF THE CONTINUOUS LIGHT SWEET CHUDE 0IL FUTURES FROM MARCH 2006 TO SEPTEMBER 2007,
A1 (green curve) resists the market untll the divergence in OBV suggesis thal the swing low beginning in mid-January 2007 will be the
sian of a new trand, Accordingly, an M {support) curve is immediately plotted (S1, red plal). As ihe irend develops, younger curves such
55 52 (blua plot) must alsa be created, A market can usually support/resist four 1o five curves befora reversing, As such, this number

of curves |s a dependable overboughtioversald Indicstor

The formula was first encoded by Levine soon after he
began writing his articles for Windows On Wall Street, the
now-ohsolete 19905 trading platform, By the time Levine
finished his articles, he andhis co-developer Stokes Fishburne
had made Mipas available in o software platform called
WinMidas. At the time of Reyna’s article in 2001, Fishburne
was still making trial copies avalable without technical
support, Currently, however, while the WinMidas websiie is
back onling, the actual MiDAS indicators are no longer avail-
able to the trading public,

To demonstrute the power of MIDAS on the longer-term
trading horizon to the position traders who may be reading
this, we can supply one illustration, though such readers
should consult Reyna's article where the longer-term predic-
tive power of MIDAS is highlighted on & number of stocks,
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curves. Note, too, the
blue curve (52) from
March 2007, which
has been created as the
trend develops.

It 15 an important
part of Levine's ap-
proach to MIDAS that “younger” curves should be plotted as
the trend develops. This embodies his idea that the markets
are related hierurchical fractals of support ond resistance.
Levine wus of the opinion that a trend could support (or resist)
a maximum of four to five curves before it ended.

A final component of this chart is Joseph Granville's on-
balance volume (OBV) indicator, which will be discussed in
maore detail later. In Figure 1, the foct that the price low of
January 2007 is not confirmed in OBV means that R 1 is likely
o be penetrated by price and therefore that 51 is going to |
hecome a new genuine support eurve 1o 4 new price trend. We
will examine in more detail the engineering aspects of MiDas
in the context ol intruday charts.

For position traders and longer-term swing traders, the
MetaStock formula code lor plotting MIDAS on the daily
charts s supplied as the first code in the sidebar, “Program-
ming MIDAS and 1-MIDAS in MetaStock.” As noted in tenet
4, the formula ts symmetrical, meaning that only the place
where the formula is launched differs in application and not
the formula itself.

On dropping the MiDaS indicator onto a daily charn,
MetaStock will prompt for the starting month, the starting
day of the month, and the starting year. To obtain a better
understanding of these ideas, position traders and longer-
term swing traders can follow the application of MIDAS 1o
intraday charts, The same principles will apply.

L PPLYIS YIILDAS Ti0) INTREADAY CHARTS

What mukes the application of MIDAS to intraday charts so
compelling is a central ténet of Levine's market philosophy,
that the underlying order is a fractal hierarchy of suppor
and resistance levels. Levine did not consider the implica-

tion of fructal organization for other chart time (rames. But

it is o central part of his application of MIDAS to the daily |
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charts that Mipas curves should be plotied on smaller
componpents of the wend as well as its lurger compaonents,

We have just seen an instunce of this in 82 (blue curve)
plotted from March 2007 as the trend in crude oil develops.
And we have also seen an important implication of this idea,
namely that trends cannot, in Levine's opinion, suppor
(resist) more than four o five curves, All we are doing is
extending this iden further by exploiting a central idea in
fractal concepts of the financial markets, namely that they are
self-similar at all degrees of trend.

The only difference in intraday charis is the obvious
localization of volume and the launch point o o particolar
intraday reversal bur, marking an appropriate swing high or

FIGURE 2; 1M CHART OF XETRA DAX mm FUTURES. Whatever he frend, be it daily o infraday, once It duvmm and
hecomes mature, newsr support or resistanoe curvwas must ba plotied. Hare, in line with Paul Lavine's view that bour o five cutves signity
an ovarboughloversold market, (he rand compleles after RS (dark blue curva) has been ploted.

I A day bar, MetaStock will
prompt for the saine
three jtems of data as
described previously in
addition to the hour and
minute. All this datn is easy o obtain in MetaStock simply by
hovering the mouse-poinier over the bar 1n guestion.

ExGINEERING [-MIDAS FOR DAYTRADING
Levine discussed the engineering aspects of MIDAS in the
context of the daily charts, but all of his trading rules can be
applied to intraday charts. Figure 2 is a 1M chart of the
March 2008 Xetra DAX index futures from February 21 to
25, We shall use it w illustrate Levine s truding ideas before
adding new observations unigue to the application of 1-
Minas to dayirading.

Paul Levine's position trading rules trunsferred from daily
charts w intraday chars:

low {more on the choice of bar later ), Here we notonly require
PROGARAMMING MIDAS AND |-MIDAS IN METASTOCK

Code 1: This code is for MIDAS to plot on the daily charts in

MetaStock in the way originally conceived by Faul Levine,

Users will be requested to Input a year, month, and day
corresponding to an appropriate swing high or low.

{User defined input}

sm.=Input{"starting month",1,12.1);

sd:=Input{*starting day of month",1,31,1);
sy:=Input(“starting year",1880,2100,2000);

atnrt'- st=DayOiMonth() AND sm=Month() AND sy=Year();

{mid price]

pv:=MP(})"V;

{Midas calculation)

danom:= I{Cum(V)-

ValueWhen(1,start, Cum(V))=0,1, Cum(V}-

YalueWhen(1.start, Cum(V)));

Il(BarsSince(start),(Cum{pv)-ValueWhen{1 start, Cum{pv)))/

denom MP())

Code 2: This code Is for I-MIDAS to plot on any intraday charn
in MetaStock Pro. Users will also be requested to input the hour
and minute. Speed can be anissue when a number ol M curves
are plotted in MetaStock and MetaStock Pro. This is an area
currently being worked on by the authar.

{User defined input)

smi=Input{“starting month",1,12,1);

st:=Input(*starting day of month",1,31,1};

sy:=Input{"starting year",1980,2100,2000}),

sh:=Input(*hour”, 1,24 1);

se:=|nput(*minute”,0,60,0};

slart:= sd=DayOfMonth() AND sm=Manth{) AND sy=Year()
AND sh=Hour() AND se=Minuta{);

{mid price]

pv=MP()*V;

{Midas calculation]

denom:= I{Cum(V)-

ValueWhen(1,start, Cum(V))=0,1.Cum(V})-
ValueWhen(1,start, Cum(V))};

if{BarsSince(start), (Cum(pv)-ValueWhen(1.starl, Cum{pv)))/
denam,MP()) —AC
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1 As n trend develops, a hierarchy of support (resistance)
curves cian be created from newer support or resistance
levels in the case of o downtrend. In Figure 2 this is well
illustrited, Here, R1 (blue curve starting from the blue
arrow ) offers the broadest resistance to the market when

As a trend develops, a hierarchy of
support (resistance) curves can be
created from newer support or resistance
levels in case of a downtrend.
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| FIGURE 4: 1M CHART OF XETRA DAX MARCH 2008 FUTURES WITH FOUR SUPPORT CURVES. Once the trand changes. In fhis
case Irom a downtrand to an uptrend, new suppont curves must immedialely be plotied. Hers we have the convarse sitaation to Figure b e
2 with ragard to the plotting and interpretation of M curves. The trend ands atter the creation of & fourth M cunve, elusticity,” mean-

3

of what he called
price “porosity” or

ing that price will
sometimes penetrate a curve by a small margin before
responding o it. We can see several instances of poros-
ity on Figure 2. The most emphatic example can he
found above the green *1,” while the price action above
“2" apd below *3" also provide illustrations.

In a downtrend, resistance curves will usually become
support curves when they are penetrated (and vice versa
foran uptrend). Examples in Figure 2 revolve around what
happened after the market closed against R resistance on
February 22. The following day, the market gapped up
before finding support on R 1. Luter in the day, R1 support |




BT' Safe and Secure since 1992
Bright Trading, LLC
JOIN BRIGHT TRADING IN 2008!!!

FREE TRADING WORKSHOP
SOUTH FLORIDA - OCTOBER 2008

CHECK WEBSITE FOR DETAILS
[008, BRINKE AuD TOME OF TRAINING!

SCHOOL & BOOT CAMP 4X PER YR
CHECK WEBSITE FOR NEXT GROUP.
PLAN AHEAD, REGISTER EARLY!

OPEN A BRANCH LOCATION

OR BE AN INDIVIDUAL TRADER!
FEEL FREE TO CALL DON BRIGHT
DIRECTLY AT 702.739.1393

Trade from one of our nationwide locations...0R
“Bright-at-home” Proprietary Remote.

# Use our Capital / Professional platiorm
7 Advanced strategles ¢ 3 Day Trading Classes
4 Low Cosis / 2-1 Week Boot Camps

www.stocktrading.com
800.249.7488

Ear mone information circla Mo 3

il Markot Technicians Association, Inc.
Chartered Market
Technician

What sets you apart from other
professionals in your field?

CMT. the only designation for Technical
Analysts that qualifies as a Series 86
exemption Recognized by FINRA.

L] L L
Registration is Open
Sign Up Now

More info: marie@mta,org or 646-652-3300

For more intermation clrcle No. 21

A2 * Sepumnber 2008 * Technival Amilyris of STOUKS & COMMODITIES

[ INDICATORS |

becomes R1 resistance, ugiin as price breaksdown through
w1 " Likewise, RS (dark blue) becomes mujor
creatng

phove
support instead of resistance above 1" and “2.”
two dramatic intraday surges.

4 To gain insight into whether a supporl curve 1s likely to
| evine used Grinville's OBV.
ORv also uses cumulative volume. though LAVIRE prelciicu
1o use the midprice instead of the close. In effect, OBV
measures the strength of the support curve by penerating its
pwn signals. To the uninitiated, these boil down to whether

TR

wisperting  prce

OBV is confirming price, In & downtrend. OBy should be
falling with price: a divergence I8 & warning that the trend 1
weakening. In general, any change in OBY that precedes a
change in price should be tken as sdvance notification that
price oo is likely 10 reverse, il not consolidate

A thorough overview ol the merits of applying OBV 1o
intraday charts can be found in the January 2004 S&C, in
D.W. Davies’ article “Duytrading With On-Balance Vol

ume.” 1 we turn to Figure 3, which is merely Figure 2 with
OBV added, we can see that OBV begins trending upwird
for several hours going into the close of February 22 while
the price repeatedly tests @ bottom created severnl hours
earlier. This positive divergence with price would be a
strong signal for Levine thist the vitrious resistance Curves
would al some stage come under severe pressure from
price. This is what we see in the last hour going into the
close when price breaks every resistunee curve except R 1,
the most dominant of the curves plotted from the very
heginning of the downtrend at the major swing high of
February 21

§ Once a probable bottom 1510 place, the MIDAS indieator

can be plotied from the swing low to create i SETIEs iff
SUppOTL curves In Figure 4 we have simply moved the
charton a few days and added {our such curves. S1 (blue)
through to S4 (magenta). Iy trend ended after the fourth
curve was plotted, agun supporting Levine's view thata
market cannot support or resist mote than four Lo five
curves. Again, the chart would be too husy if ull of the
support areas | buy signals) created by these curves werc
highlighted, The reader can agimn identify these for
himself,
Notable areas of porosity inc lude the areas highlighted by
blue rings. Suppon also becomes resistance over on the
faur rigght of the chart highlighted by the red circle, What
we have wlso done in Figure 4 is plot o resistance curve
highlighted by the dark blue arrow from the intraday high
of February 26, There is a fair amount of porosity 1o
begin with, but the line guickly conjoins other support
curves inside the red circle

At this stage, @ truly short-term daytrader might object that

| while these intraday charls are an impressive illustration ofl
Minas, the indicator simply does not generate enough sig-
nals for a very active daytrader. This objection would nol be



well-founded. as we shall see ona much
closer examination of intruday price
action.

The charts we have so far considered
were used o illustrate the main tenets
behind Levine's own approach to using
Mipas. In the next issue, we will look a
a few more charts of even higher intraday
resolution to highlight several additional
features of MIDAS (or |-MIDAS, its
intraday counterpart), which have
emerged as a result of personal expen-
ence in researching I-MIDAS.

Andrew Coles ix based in the UK and
hay a master’s degree and o doctorate
in the history of seience. He hax a di-
ploma in technical analysis from STa-
K and fromm the International Federa-
tiom of Technical Amalvsts (IFTA ) He is
alse a Certified Financial Technician
(Crre). He can be reached ar
andrew_coles@ ownmail.ner,
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| Watch The FREE Volcone Demonstration Now At: |
I www.VolconeSoftware.com/video 1
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aise|
CumVal = CumVel_1+nVolume;
CumPricaVol = CumPriceVol_1-+(nMP*nValume);

]
H(Start==talse && month(0j==xMonth && day(0j==xDay &&
year(0)j==xYoar &4 hourDj==xHour &8 minule(D)=xMinute) |
CumVolAtStart = CumVal-nVolume;
CumPriceVaolAiSiarnt = CumPriceVol-(nMP nValume);
BarCourter=1;
Start = trus;

|
iNBarCounter==0)|
ralurm;
jeise f{BarCounter==1)|
vill MIDAS = nMP;
Jelse il(BarCounter=1)(
var Denom = CumVol-CumVolAtStart;
{Denom==0) Denom = 1,
var MIDAS = (CumPriceVol-CumPriceVolAtStarty/Denom

|
maturm MIDAS;

function vsrilm {
varb =
if InatElu.uldNumher{} < 778} (
drawTextAbsolule(s, 35, “This study requires varsion 8.0 or
later”,
Caolorwhite, Color blue,
RELATIVETOBOT TOMITeod. RELATIVETOLEF TTText. BOLDI et LEFT,
null, 18, “emor®);
drawTi

axtﬂbumfﬁ 20, "Click HERE 1o
upgrade. @ URL=htip./fwww esignal com/download/detault. asp”,
Color.white, Color.blue,
et RELATIVETOLEF Tt BOLD Teod LEFT,
null, 13, "upgrade”),
raturn b;
| elsa |
b = true;
]
\ return b;

—Jasan Keck
eSignal, a division of Interacrive Data Corp,
HIK) 81 5-8256, wiwwiesfgnalcentral.com
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+ WEALTH-LAB: MIDAS INDICATOR

We've now added the MIDAS indicator to our collection of
drag-and-drop indicators (Figure 3, inset), based on “The
Mipas Touch, Part 1" by Andrew Coles in this issue.

By including the starting bar number as o parameter, the
indicator is fully programmable. and our script demonstrites
how a number of MIDAS curves can be effontlessly added 1w
a chart for quick viewing, The script plots five MiDAs
indicators for the most-recent 7% peaks and troughs (Fig-
ure 3,

WealthScripl code:

[f Code tor Exscuts method

i Dont forgnt fo add: using TASCindicators;
const int¢ =8

cons| double pet = 7d;

Calor] color = new Colorfc];

aolar((] = Color Blus;

RRERE. LI

g

et Sme
FIGURE 3: WEALTH-LAB, MIDAS INDICATOR. Thi indicators were plofid hire automaicaly

uy;:r:mrrmngammﬂemhﬂmﬁmrﬁ:mumhwmmmulﬁmmm |
nw MIDAS indicator

{::Glﬂutﬁld ‘

h 4! = Color, Green;

DataSeries ap = AveragaPrice.Serles(Bars),
DataSerias phSer = PeakBar. Series{ap, pct, ‘
PeakTroughMode. Percant); [
DataSeries tbSer = TroughBar. Serles(ap, pct,
PaskTroughhMode. Percent);
int bar = Bars.Count - 1;
Intn=0;
while [bar =1 && n < g)
{
Int pb = (int}jpbSarbar];
int 1o = (in)thSer(bar].
bar = Math Max( pb, th );
DataSerles midas = Midas. Serlas(Bars, bar)
PlotSeries(PricePane, midas, colorn], Lln:ﬁmu Saolid, 2);
n+=1;
bar =1,

— Rishert Sucher
waunwealth-lab,com

AmiBroker

L e |

+ AMIBROKER: MIDAS INDICATOR
In"Exumining The VwaP Approach: The MIpas Touch, Pant |
1™ in this issue, author Andrew Coles presents o variant of the |
volume weighted average price indicator. Coding the Minas |
indicator is very easy and straightforward in AmiBroker,

Listing | shows a ready-to-use formula for both end-of-
day and intraday charts, When using it for end-of-doy chang
simply leave the time setting untouched. The single formul
allows up 1o five MiDAS plots starting from different daes!
mes, If you need more, simply replace the number 5 (o the
“for” loop with any numeral of your choice.

To usie the code, simply enter it in the Formula Editor, then
choose the Tools->Apply Indicator menu from the editon You
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FIGURE 4: AMIBROKER, MIDAS mmn Here 1 a dally chart of DIL with
Iwa MIDAS ines. You can use tha paramatar window to adjust starting dates of
up 1o five MIDAS indicators,

can use the parameters window {available from the right-click
meni) Lo set the starting dute/time for MIDAS plots.

LISTING 1
Plotl €, "Price = + Data(), colorBlack, styleCandio );
Iﬂlq‘.l=-1:i-==5:i++]

startdate = ParmmDate("Starting Date " + 1, “2000-01-017):
starttime = ParamTime{"Starting Time * + |, *00:00:00" ),

start = DateNumi) < startdate AND TimeNum{) <= startlime;

mp = (HHLY2
pv = Valume * mp;

danom = Gum{ V ) - ValusWhan( start, Cum( V ) );
nom = Gum| pv | - ValueWhaen( start, Cumi pv ) );

midas = Il BarsSincel start ), nom/denom, Mull ),
Piot{ midas, "Midas" + |, colorRed + |, stylaLine | styleThick |
styleNoRescale );

A sample chart is shown in Figure 4.
— Temriccs Janeczkio, AniiBrokercom
wwamibroker com

+ NEURDSHELL TRADER: MIDAS INDICATOR

The MipAS indicator described by Andrew Coles
in “The Mipas Touch, Part 1™ in this issue can be easily
implemented in NeuroShell Trader by combining a few of
NeuroShell Trader's 800+ indicators. Select “New Indicator
<" from the Insert menu and vse the Indicator Wizard to
create the following indicators:
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FIGURE 5: NEURDSHELL TRADER, MIDAS INDICATOR

BARMLIM:
CumSum{Add2(1,0),0)

BARVOLUME:
If ThenElsa{A==B[ BARNUM, StariBar# ), Volume, 0)

MIDAS:
Divide! CumSum( Multiply2( Avg2( High. Low), BARVOLUME ), 0).
GumSum(BARVOLUME, 0 )

As deseribed in the article, the MIDAS indicator should
only begin computing after clear reversals in trend as
identified visually on the price chart. The Mipas indicator
formula given above accomplishes this by begimming com-
putation on the bar number identified by the StartBar#
parameter. To determine an appropriate StartBar# value,
insert the BARNUM indicator on your chart and set the
MIDAS indicator’s StartBar# to the BARNUM indicator’s
vitlue at o visually identified trend reversal.

A sumple chart 15 shown in Figure 5. For more information
on NeuroShell Trader, visit www.NeuroShell.com.

—Murge Sherald, Ward Svstems Group, Ine,
JO1 662-TIS, saley S wardsystems, com
wiwL enrosiied] com

COGsz

4+ COG: MIDAS INDICATOR

Here ts a COG custom study definition based on the article;

“Examining The YWaP Approach: The MiDas Touch, Part

1" by Andrew Coles. A sample chart is shown in Figure 6,
The study shown here matches the Excel spreadsheei

calculations used in George Reyna's 2001 STOCKS & CoM-

MODITIES article *Volume-Weighted Average Price For Sup-

port And Resistance™ referenced in Coles’s article in this

issie,

i* 1) Creale Parameters:...... manth...day....year...hour and
minuie.... Thesa are case sensitive.
2) Check tha overlaid box whan creating this custom study.
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FIGURE 6: COG, MIDAS INDICATOR

| 3) Add o chart _.right click fo modily... set dispiay scale 1o ON
from AUTO
‘ 4) In addition, 1o recreate this study you will need 1o add a

parametsr
called PerodForSummation, insert info the sum function, then
delete this fram list of parameters.®/

DallyTime:= Maonth(@ }=manth AND Day(®j=day AND
Year( @ j=year;
| IntraDayTime:= Hotr(@ )=hour AND Minute{ 8 )=minute:
Time:= IF( Barlnterval| @ ,none] < Barlnterval( @ D), DailyTime AND
IntraCay Tima, DailyTime);
PariodForSummation:= BarsSince(Time,1,10000}+1;
Cumvol = Sum(Vol( @), PariodFarSummalion);
CumMidAndvioli= Sum{Mid| @)* Vol( @), PerlodForSummation),
VolOnDayOne:= Vol(@) WHEN PerindForSummaltion=1;
MIMDWMWMWHEN PeriodForSummations=1;

MidasVWAP:= IF{PeriodForSummation = 1. Mid{ &},
{Cumuwmmmnmvﬂmmcumw-wmm}};

| A Coa component pac is available at the CoG website
lhllp:ﬂwww,cqg_uu:m!iuppurUDuwnIumLu.a:ipx: for install-

| ing this study in COG,
Thom Hartle
| www CQG, cam

| ii] AMERITRADE

'+ TD AMERITRADE'S STRATEGYDESK: MIDAS INDICATOR
| Tuhilo nrtwele in thia iacua, “Evamining The VWAP A[Iﬂr{lm:h:
The Minas Touch, Part 1" Andrew Coles highlights a
trading system using volume-weighted average price (VWAF)
| calculations. This system, developed by the late physicist and
technical analyst Paul Levine, cian be used 1o create support
and resistance curves that can apply to both short and long-
term time frames. Here is an interpretation using TD
| Ameritrude’s StrategyDesk.
In the article, Coles discusses how volume-weighted nver-
| age price can be used to identify support and resistanee curves

sa & Salll N e AR
FIGURE 7: TO AMERITRADE STRATEGYDESK, MIDAS INDICATOR. Google inc.
{Mbmm&ﬁnmﬂm&mﬂ.lhﬂmmb&wmp&m MIDAS on
{rve daily chart shown hara, A lowear indicator has been nddad tha! identifies the on-
patance volumea (OBY) for the same period

following o clear trend reversal. Using Strategy Desk, these ‘
curves can be created as custom chart studies using the
volume-weighted moving average formuliashown here. Again,
since this system is based on a reversal in trend, we must be
mindful of the reversal’s starting point.

(Bar{Date,D] = 20080817) * (MovingAverage[VWMA High.1,0.0] +
MovingAverage[VWMA,Low,1,0.00) / 2 + (Bar{Date D] = 20080618) *
(MovingAveraga[VWMA, High,2,0,0] «

MovingAverage[VWMA Low,2,0,0]} /2 +

(Bar{Date,D] = 20080818) * {MaovingAveraga[VWMA, High,3,0,0] «
MovingAvarage[VWMA Low.3,0,00) / 2 + |{BarData, D] = |
20080820) *

{MovingAveraga[VWMA High,4,0,0] + |
MovingAverage(VWMA, Low4.0,00) / 2 +

(Bar{Date,D] = 20080623) * [mmmm.&ﬁm.ﬁ.ﬂ,ﬂ] +
MovingAverage[VWMA Low,5,0,00) / 2 + (Bar{Data,D] =
mqu -

MovingAverage[VWMA, High,6,0,0] +

MovingAverage[VIWMA Low,6.0.01) / 2 +

(Bar(Date,D] = 20080625) * (MovingAverage(VWMA High,7.0,0] +
MovingAverage(VWMA, Low,7,0,0]) / 2 + (Bar{Date,D] = I
20080626) *

(MovingAvarage[VWMA High8,0,0] + |
MavingAveraga[VWMA,Low.8,0,0]) / 2 +

(Bar{Date,D] = 20080627) * (MovingAverage[VWMA, High,8,0,0] +
MovingAvarage[VWMA Low.8.0,0]) / 2 + (BarfDale, 0] =

20080630} * |
(MovingAverage]VWMA High,10.0,0] +
MavingAveraga[VIWMA, Low, 100,00/ 2 +

(Bar{Dale,D] = 20080701) * (MovingAverage[VWMA, High.11.0,0] |

*

MovingAveragelVWMA,Low, 11,0,0]) / 2 + (Bar{Date.D] = '
20080702) *

(MovingAverage|VWMA Hig, 12,0.0] + .
MovingAvaragefVWMA, Low,12,0,0]) /2 +

(Bar{Date,D) = 20080703) * (MovingAverage{V\WMA High,13.0.D] + |
MavingAverage[VWMA Low, 13,00} / 2

Using StrategyDesk, itis possible to track multiple suppor |
OF resistince curves al once, as new trends begin. As is also |
discussed in Coles’s article in this issue. an on-balance
volume (OBV) indicator can be upplied to the chart. See
Figure 7.
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If you have questions about this formula or functionality.
please call TD AMERITRADE's Strategy Desk help line at 800
228-R056, free of charge, or access the Help Center via the
StrategyDesk application. StrategyDesk 15 u downloadable
application free for all TD AMERITRADE clients. Regular
commission rates apply.

TH AMERITRADNF and Stratepvllesk do ner endorse or
recomimend any pan‘!'m.’ﬂr trading straregy,

—Jeff Anderson
TD AMERITRADE Holding Corp.
Wi it riteadde.com

A
o
AIQ + RI0: MIDAS INDICATOR
The A code for Andrew Coles's article, “The

Mibas Touch, Part 1, is shown here. The author's version of
the indicator, which is a variation of a volume-weighted
moving average, is oriented toward discretionary trading
because it requires visual examination of a chart to determine
the significant low and high dates that are then input manually
into the indicator before it can be used.

I prefer to work with mechanical methods that can be
backtested, so when | coded Coles’s version of the indicator,
1 converted the indicator to an adaptive one (RD Vwar) that
awtomatically finds the most recent high and low pivot dates
and then plots the Vwap automatically from these dates. My
version of the indicator will plot automatically on any chart
and the only input required is the strength (bars on each side
of the pivot),

To test the indicator, | devised o simple trading system
based on a trend-lollowing technigue of buying when the
close crosses above the Vwar adaptive indicator. 1 ran
simulations using the Naspag 100 list of stocks. To run tests
on a partfolio level, | used the following trade selection rules
and capitalization rules: the trades were selected using 32-
day A0 relative strength, tuking the top three strongest
signals per day, 10% of capital per position, with a maximum
of 10 open positions, Positions were exited on n reversing
signal,

| was curious as to whether the new indicator would
outperform a simple moving average crossover (SMACO)
system. | used a moving average length equal to 2 times the
strength parameter of the VWAP +1. 1 ran comparative tests
over the period 10/15/2002 10 7/1 1/2008 using the same list
of stocks and the same exit conditions, with the difference
being in the indicator driving the entries and exits. On the
long-only test comparison, shown in Figure 8, the RD Vwap
adaptive system (blue line) showed almost identical results o
the SMACO system (red line) on all the various metrics. The
short-side-only test comparison (not shown) was also nearly
identical to the standard moving average crossover system.
For both systems, shorting the NASDAQ 100 stocks during the
test period (which is mostly a bullish period) lost at the rate
of 27% per year. Both of the systems need market timing and/
or trend filters to make the short side work. A trend filter

76 * Seprember 2006 ® Technical Anafyris of STOCKS & COMMODITIES

4 s A
3 ",

| #’, A

e (B - -
Y R
e e e

= 2 3§ §

s

il
il

Frd [

FIGURE B: AIQ, MIDAS INDICATOR. Here is a comparison of RO YWAP adaptive and
SMACD systems {lang only). The RD VWAF sysiem showed no significant ditference

from the SMA systam in a portolio simulation using the NASDAC 100 stocks.

might reduce the drawdown from the long side as well.
The code can be downloaded from the AIQ website al
www.aigsystems.com and also from www tradersedge
systems.com/iraderstips.htm, or cun be copied and pasted
from the STOCKS & CoMMODITIES website at Traders.com.

| MIDAS TOUCH AKA VWAP INDICATOR
| Author: Androw Coles, PhD, TASC September 2008
| Gaced by: Richard Denning 7/08/08

| INPUTS:

Manth1 is 06, Day is 05.Year! is- 2008 .
Month2 s 003, Day2 is 17 Year2 is 2008 .
Month3 is01. Day3 is 23, Yeard is 2008,

Monihd is 12, Day4 Is 11 Yeard is 2007.

I VARIABLES

bars1 is OfSetToDate(month day 1 yearl).
bars? s OffSelToDate(month2.day2 year2
bars3 is O1SetToDate{maonthd, day3, yeard).
barsd  |s OfSelToDate{monthd dayd yeard).
datat is makedate{month1 day1,yeart ).
dae?  |s makedale(month2 day2 year2).
dated s makedate mdnm.dnrﬁ.mrﬂi.
dated s makedate(manihd. dayd yeard).
MP Is ilﬂiﬂhhﬂmﬂf’?

W i@ [voluma)

CPYV1 is sum({MP * V. Abars1).

CPV2 s sum{MP * V,"bars2),

CPV3 s sum(MP * V bars3),

CPV4 s sum{MP * V Abarsd).

cv1 s sum(V,*bars1),

cva2 is sumiV,fbars2).

cva Is sumi{V,Abars3).

cv4 is sumi(V,Abars4).

| DISCRETIONALRAY INDICATORS TO PLOT:

VWAP1 s ift{reportdate()=date1 and CV1=0, CPV1 / CV1,M
VWAPZ s illireporidats(}>date? and GVZ=0, CPV2 / CV2 MP).
VINAP3 s ifl{reportdate(}>daled and CV3=0, CPV3/ CV3 MP).
VWAP4 s iff(reportdate()=dated and CV4=0, CPVA /| CVAMP).

D VWAP ADAPTIVE INDICATOR
|1 PIVOTS-TWO LOW AND TWO HIGH
| Coded by: Richard Denning 9/12/06

ICOMMON SETUP INFORMATION
mudn ls 252  ITotal look back period
ne strength 12,
INumber of bars on each side ol pivot
aTo is




TRADERS’ TIPS

OftsatiodateMaontinl ), Dyl ). Year())

LowR I Lovial([low], (2°strangth)+1)
LowM I8 Val|[low] strengih)
LS Il LowF = LowM
HighR s HIVal{[high], (2" strangth)+1)
HighM is Val([high],strangth)
HS il HighA = HighM
IFIND FIRST PIVOT LOW
LT1 I& soanany(LS, periods) then OTD
Lo |& ALT1 + Strangth
LO1de is SetDain(LO1)
LowlCH is val{[low],~LO1)
IFIND SECOND PIVOT LOW THAT IS BEFORE THE FIRST PIVOT LOW
LTra I& scanany(LS, panads,LO1]) then
oTh
LOZ I8 ALT2 + Strangth
LO2dte I8 SelDale(L02).
LewlO2 is vak{[low] ALO2)
IFIND FIRST PIVOT HIGH
HT1 is scanany(HS, penods,0) then oTh
HO1 I8 AHT1 + Strength
HO1die s Se0ate(HOT )
HighHO |5 wal{[high],HO1}
IFIND SECOND PIVOT HIGH THAT IS BEFORE THE FIRST PIVOT HIGH
HT2 s asanany(HS perlods HOT) then
oTD.
HO2 is "HT2 + Strangih
HO2dta s SatDale(HOZ)
HighHO2 is val{[high] HO2]

hars5s ia min{LO1 HO1)
CPVE s sum(MP * ¥V bars5)
CV5s Is sum(V,barss)

| A0 VWAP INDICATOR TO PLOT
VWAPS s II(CVE <= 0, CPVY5 | GV5, [close])

| VWAP ADAPTIVE CROSSOVER SYSTEM
HD i hasdatalon300)==252
ILong Entry rule:

LEvwap Il HD and countol{[closa) = VWAPS,2)=2
ILong Exit rula:

Lxvwap il countol(jclose] « VWAPS,2)=2
1Shart Entry rula:

SEvwap il HD and countoi([close)] < VWAPS,2)=2
1Shart Exit rule:

Sxvwap Il countol{|closa] > VWAPS 2)=2

| SIMPLE MOVING AVERAGE CROSSOVER SYSTEM
ILeng Entry rule

LEsma I HD and countal([close] = simplaavgl[close] 25) 2)=2
ILong Exit rule:

Lsma il HD and countol([close] < simplaavg([closa] 25) 2)=
IShort Entry

SEsma il HI
1Shor Exit rule:

S¥asma it HD and countol([closa] = simpleavg(lclosa] 25),2)=2

and countol{[close] < simpleavg|[close],25) 2)=2

Richard Danning
LIQ Suvtems

ichitrd, denning @ earthlink.ne

+ TRADERSSTUDIO: MIDAS INDICATOR
The TradersStudio code for Andrew Coles's article i thas
issue, “The MIDAS Touch, Part 1,7 is shown here

The code for the author's version of the indicator, which 15

FIGURE 9: TRADERSSTUDIO, THE MIDAS INDICATOR. Here i an axamphe of
e RD VWAP indicator Ehown an f reverss-a e chart of cruda oil with & 12
bar pivolswng rength in TrackersStudies The lines slap when (he Indicalar
WOl Swing paint

recogmizes a newly lorm

Comparisan of Koy Statislics
TradePlan is TS_PERCENTHARGINPLAN{ 10, 100) |
Tesi Period: 12/24/ 1962 to 7/11/2000 |
YWAP ___SHA
Parformance Summary: All Trades i |
Tatal Het afil SEasaad L
| Maw Intragay arasaown 163, 420) (704,958} |
1 | 114 1
Het Profit / Hax arawdown 245 1 Bk

Perfarmanco Jullil'll"lrj' Long Trades

Totlsl Ne srrasss SsEssEsE
Ha miraday drawdown 5 O%8 LEEY.BY 1)
Frofly TH | 1.2 |

| Hel Prof it / Max drawoown o ] 1.7
Parformance Summary: Shorl Trades

| Totdl Net Fralil 206 4635 37.91;

| Hax intraday drawdowr (BE T 424 |
Frafil FacLEf (i} 2
Mot Profi Hax drawdown 024 01§
Favere adjised, continuou s cond i 8 porfiolio Ussd Drabove e
Ceatan, EumCumncy, Coppe Gas, Sugar, Tan-Tanr T-Merim |

FIGURE 10: TRADERSSTUDIO, VOLUME-WEIGHTED ADAPTIVE PRICE SYSTEM
VS. SIMPLE MOVING AVERAGE CROSSOVER SYSTEM. Ths vl

NOWE &

MA \-\n-u n ,|r|1._
uE CONtracts

15 histed

a variation of a volume-weighted moving aver

under the heading “Midas Touch Indicator.” Because | prefer
1o work with mechanical methods that ean be hacktesred, |
converted the indicstor to an adaptive one (RD VWAP] that
automatically finds the most recent high and low pivot dutes
and then plots the VWAP automatically from these dates My
version of the indicator will plot automatically on any chun
and the only input required is the strength (bars on each side
of the pivot)

| created o function tocompuie the RD VWap, shown under
the heading “RD Vwap Adaptive Moving Average.” This
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function is called to create the indicator plot, shown under the
heading “RD Vwap Adaptive Indicator.” This indicator plots
three VWAP moving averages. The fastest VWAP average
starts from the most recent swing high or swing low. The
secand ¥ WAP starts from the next most recent swing high or
swing low pair. The third VWAP stanis from the third most
recent pair of swing high or swing low. The closer of the two
in ench palr set is used in each case, The RD VWAP indicator
is shown in Figure Y on a chart of crude oil.

T test the indicator, | devised a simple trading system
hased an o trend-following technique of buying when the
close ctosses above the Vwarp adaptive indicator. The code
for this svstem is shown under the heading “RD Vwap
Adaptive System.” For this test, Tused the fustest of the three
lines, I ran simulations using o diversified portfolio of re-
verse-ndjusted futares contracts consisting of collon, euro
currency, copper, Japanese yen, natural gas, sugar, and 10-
year T-note. To run tests on a portfolio level, Lused one of the
trade plans provided with the software called the
TS_PercentMarginPlan, ( The code for this is not shown since
it is provided with the software.) This plan bases position
sizing on the margin requirements for ench futures contract,
1 used a 10% parameter, which means that 1 used only 10% of

| the available levernge on each contract. Positions wereexited
on a reversing signal.

| was curious as to whether the new indicator would
outperform a simple moving avetage crossover (SMACO)
system. [ The code for the SMACO system is not shown but is
posted at the websites mentioned below.) 1 used o moving
avernge length equal to 2 times the strength parameter of the
VwAP |, | ran comparative tests over the period 12/24/1992
10 7/11/2008 using the same portfolio of futures and the same
exit conditions. with the difference being in the indicator
driving the entries and exits. The results of the tests are
compared in the table in Figure 10, which shows the RD
Vwap aduptive system performing somewhat better than the
SMACO system on all the varions metrics, The long side on
both systems preformed considerably better thun the short
side. The RD VwAP indicator appeirs to be worthy of further
research, The stepping nature of the RD VWAP might make it
an excellent trailing stop,

This code can be downloaded from the TradersStudio
website a1 www. TradersStudio.com ->Traders Resources-
SFreeCode and also from www tradersedgesystems.com/
traderstips.htm.

* MIDAS TOUCH INDIGATOR

* Author: Addrew Cales, PhD, TASC September 2008

 Cioded by: Richard Denning 7/11/08

Sub MIDAS_|(date1, date2, date3, dated)

‘date Input format =

Dim baa1 bars2, VWAP1,VWAP2,VWAP3 VWAP4 As

Bara )
Dim ;Arlﬁ.’mWL cumPVE2, cumPVa, cumPVa As Double
Dim cumV1, cumV2, sumi3, cumVd As Doubls

MP = (H+L)/2
‘gomputa and plot fing starting from data
‘ If Date > MigrateDate(datat)

T8 = Sepicinber 200K * Tochuical Anaturis of STOCKS & COMMODITIES

= = & |
|

I

bars! = bars1[1] + 1
cumPV1 = summ(MP * V, bars1) '
cumV1 = summiV, bars1)
W cumWy1 = 0 Than |

VWAP1 = cumPV1 / cumV1

plot1 (VWAP1) |
End i

Elsa

barsl =0

End it
'‘Compute and line sla from date: ‘
Oonpe and i o g e

bars2 = bars2[1] + 1

cumPY2 = su *V, bars2)

cumv2 = , bars2) |

il eumV2 > 0 Then

YWAP2 = cumPV2 / cumV2

If cumy4 = 0 Than
VIWAP4S = cumPV4 [ cumyd
plotd(VWAPA)

End If

' RO VWAP ADAPTIVE MOVING AVERAGE (FUNGTION
 Based o article by: Addrew Coles, TASC September
* Author: Richard Denning

' Goded by: Richard Denning 7/12/08

meﬂﬁﬁw.mw

* strength is swing hig bar pivot inpuit as integer

' Min value = 1, must ba »= strangth * 25
'mﬂnﬂmﬂmmﬂmmm-ﬂmmhuutﬂm

Max value =3
R
1 swlow? swLowd As

Dim bars1,ba
Dim swHight
i 1, VWAP2 VWAP3 As BarArmay
 cumPY, cumPV2, eumPV3, cumV1, cumV2, cumva As

&

|

i

g
3
i3
~>
¥

= SwingHighBar(1, H, strength, langth
unm- ighB ﬂ“‘“‘"""“"‘s
swlow! =5 gLo -. Lmr.
swlow? = 5 Aar(2, L. strength, lsngth
swlow3 = Swingl i L. swwangih, length |
ﬂ‘ﬂaw
haarsd = M swl.owd)




* RD VWAP ADAFTIVE INDICATOR
Busedanmhhw Addrew Coles, TASC Septamber 2008

* Author: Richard Danning

' Coded by: Richard Denning 7/12/08
Sub AD_VWARP As Inleger]
' strength is swing bar pivot strangth; mnuhtnwr
C Miin value =1, must be == sira
Dim VINAP1, VWAP2, VWAP3 As BarArray
Dim avgP As Double
VWAPT = VWAP_ADPT) l
VWAP2 = VWAP_ADPT utrmuﬂ'p,z
VWAP3 = VWAP_ADPT strength,J}
I BarMumber = 502 Than

Plﬂ"m'»‘!-"T'

plot2
Ep VW,

plot1 (avgP)

plot2(avgP)

avgP)

End If
End Sub
‘A0 VWAP ADAPTIVE SYSTEM

* Based on article by. MMMTASCSWWM
* Authar; Richard Denn
'cududnrnwdnmmmam

Bm VIWAP 1P{strangih As Integet, swBarNum As Integer.
O As Integer)

mnulhln bar pivot iy i
i g i vl g Cafebans o 3 g

* gwBarNum =1 use mosi recent swing high swing low bars. 2 rex

ele

' Max valus =3

‘ pumX0s = 1 use lirst cross over for entry and exit signal
2 = 2 require lwo consecutive cross overs for signals
' Min valua = 1, Max value =2

It strength < 1 Then strength =1

It swBarNum < 1 Then swBarhum = 1

It swBarhium =3 Then swBarMum =3

I numXOs < 1 Then numX0s = 1
Hnumxma-ETM!lmrm!Du 2

[im VWAP As Bar,

VWAP = VIWAP ADPTIBimnﬂﬂH]'

nmmm 1|:WH{1
M‘HE_‘VW! 1,0, Markat,

nd It
Short wit e for single XO&:
It C > VWAP Then
Emm{ﬁsx_w 1G°"1,0,Markat, Day) ‘
Hm:l-m:szn
rrc:.@fpmmlswmig Cl2] < VWAP[2] Then
B
‘Long exit rule for two
AR D vy
.i""&’”m“""u“‘i‘ﬁ'“?{“"vwm" ) Arid G{21 > VWAP(2) Then
= < >
g;;[:*ﬂlivw 1D.Mll'llllilhﬂ
‘Short exit rule for two bar XOs:
I G > VWAP and 1wwmuha
Endll ey gl o
End Il
End il
End Sub

—Richard Denping |
richard.denning @ earihlink.net

+ NEOTICKER: MIDAS INDICATOR

In “The Minas Touch, Part 17 in this issue, author Andrew
Coles presents the MIDAS indicator to help identify suppart
and resistance price levels (or any instrument. This indicator
can be written in NeoTicker using formula language (Listing
1) with one starting date/time parameter for both the daily and
intraday caleulation.

We've created an indicator in NeoTicker named “TASC
Formula 1-Midus™ with one parameter that sccepts a dafetime
varinble for the starting date and time of weighted average
price calculation. The parameter field is set to datetinte type.
NeoTicker provides s selection user interface for entering the
date and time correctly.

A sample chart is shown in Figure 11 ‘

A downloadable version of this indicator will be available
at the NeoTicker blog site (http:/blog.neoticker.com),

LISTING 1
$pv o= if{datat . datetime(0)=pamm1,
Spv+typicalprice(datai)®y, typicalprice{datal) v);
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FIGURE 11: NEOTICKER, MIDAS INDICATOR

Sdenom = l{data! datelima(0)>param1, Sdanom-+v, v},
plot! = if{data1 datetima{0)=param1, Spw/Sdanom, 0);
suocess = datal, datetime|0)=parami,

Kenmeth Yaen, TiekQuest T

WWHLTICKG ST Eom

' STRATASEARCH"
+ STRATASEARCH: MIDAS INDICATOR

Viewing the MIDAS support/resistance curves on multiple
charts indicates they can be an effective approach. In fact,
their success was fairly consistent from one symbol 1o an-
other, However, the requirement to manually enter the start-
ing dates for each MIDAS curve prevents the approach from
being backtested very easily, so thas is an approach that will
likely be appreciated more by chartisis than system traders.

As with all other Traders”™ Tips. additional imformation
including plug-ins — can be found in the Shared Arca of the
StrataSenrch user forum. This month's plug-in contains o
prebuilt custom formula and chart that will provide users with
a template for exploring the MIDAS curves further

A sample chart is shown in Figure 12

MIDAS

Igar datinad inpd
Sm=paramatar] S tingMonth™);
sd=paramatar“StartingDay);
sy=paramalan"StaringYear');

starl= (sy"10000)+{sm" 100)+&d

pu=MP{}*'V;

BA) = September 2000 * Techaical Analyris of STOCKS & COMMODITIES

Y ———

FIGURE 12: STRATASEARCH, THE MIDAS INDICATOR.
Andraw Coles, the MIDAS curves provide halphul support
me the fourth support curva (5 lace (tird &

As suggested by aulhor
sislance lines. By the
s}, the support I8 very strong

Mida 3oL i
denom=I{{accumiV}-ValueWhen{date=slart, Accum(V)) = 0, 1
Accum(V)-ValueWhen(date=start, Accum{V)))

Midas = Il DaysSinca(data=start),{ Accum{pv)-
ValuaWhen|date=atart, accum{pv) ) )/danam, MP{)}

Pete Roxt
Avarin Svatemsy, fne

wiww StraraSearch.com

TS SUPPORT
+ MULTICHARTS: MIDAS INDICATOR

This Traders' Tip for MultiCharts is based on Andrew Coles™s
article in this issue, “The MibAS Touch, Part 1."

We have created Mimas in such o way that you will not
have to worry about using the code for different resolutions,
The script identifies the type of the chart and is then calcu-
Inted necordingly. If you do not specify the input values, then,
by default, the indicator is plotted from the very beginning. 1
you want to choose a specific swing high or low, just enter the
year, month, day, hour, and minute in the regular format. The
resuli of applying the indicator to MultiCharts as described in
the article is demonstrated in Figure 13

Inpuls:
a0y,
morith_star(1)
tny alarif1)
haur stari{0y,
mintte_start(0);
variables
tateStart(0)
timaSiart{0).
Ll Violumsa{ 0y,
f e ),

tar Pric

i 0},




e —————————————————
TRADERS® TipPS

FIGURE 13: MULTICHARTS, MIDAS INDICATOR

emini SAP 500 continuous contract with (he M

Lt TR )

1P (0}
i -II_D]Z

il { mant tart < 1 ) er { monl it = 12 ) than
r.|.|-'.r:«n|rII|1'r\|"errr;r|' et TR AmELT

I{ el i <1yor(aa it = 31 ) than
ralsarantimesseon i ] Pt

W ho ot <0 ) of | hour_star > 23 ) then
ralsaruniimesot| n EL
I mimile_starl < @ ) or | minute st = 68 ) then
ralgaruntimasmaorn | 1 M 1 [ |
)
once vajusi (intportion(year_slarl) - 1900)*10000 +

intpod tan{rran il 1Ay 100 + inlportion| tarth

M {high + low)".5

liume += volumae:
PrlieaOnivolumae += MP*volume

iy bartypa = 1 and barype < 5 | 1han
condition1 = dale == valual

G

condiion = { date » valua! ) or | date = valua1 ) and [ time >

vialuee )

If conditian then

bagin
QNCa niartvorum LiFTLal v ol
once dtartPneslind HTIE umulatiaPrnce O
W { startVolume = cumuléEtveYoluma ) than
e noiT —'L
else
1] = LI 1} [

tartPriceCnviolume )/denos

I irtvalume = cumulnliveVolume ) than
vislued = MF

|’Ii:'|'.'||'..:-|.-:' 1
end:

) sampig chart of iha

anoe Valuee = intparbani nour | ::l"lﬂ{l « intportion il

=
:'II I, Py :l":i':'q.“u- Ay

FIGURE 14: NINJATRADER, THE MIDAS INDICATOR. This

gcreenshol shows [he MIDAS indicator applied on a dally chart of MSFT

T discuss this article or downlood o complete copy of the
rl'|||||||-!“- PIL'.I'~|.: visil our discussion forum at
|llrlsl:ll.I\~1.|[}||ul'l...|;|||||

Staanfev Miller
TS SUPPORT, LLA

MWW IS VERfAAcf .80

+ NINJATRADER: MIDAS INDICATOR
The MIDAS and I-MIDAS indicators, as discussed in “Exam-
ining The VWapr Approach: The MiDas Touch, Part 1" by
Andrew Coles in this issue, are available for download ot
www.ninjatrader.com/SC/September2(085C zip

Once it has been downloaded, from within the NinjaTrader
Control Center window, &elect the menu File > Utilities
Impaort NinjaScript and select the downloaded file. These
indicators are for NinjaTrader version 6.5 or greater

A sample chart is shown in Figure |4

You can review the indicator’s source code hy selecting
the menu Tools = Edit NinjaSenipt > Indicator from within the
NinjaTrader Control Center window and selecting either
“MIDAS” or “_MIDas.”

NinjaScript indicators ure compiled DLLS that run notive
ot interpreted. w provide the highest performance possible,

Ravimond Dewx, NingaTrader, LLC

W et ralier, ey

+ VT TRADER: MIDAS INDICATOR

Phus Traders” Tip was inspired by the article “Examining The
Vwar Approach: The Mipas Touch, Part 1" by Andrew

promber 2i08 * Fechmion! Anatvaiy of ATOCKS & COMMODITIES = B1



Coles in this issue. The VWAR support and resistance indica-
tor (also known as the “Minas™ indicator) was created by the
lute Paul Levine. The main goal of the MIDAS indicator is the
prediction of major trend reversals using nonlinear support
and resistance curves. The original MIDAS indicator was
designed for use on long-term daily charts, but it has since
peett adapied fon use un intradey eharts

We'll be offering two versions of the MIDAS indicator for
download in our user forums; “M1DAS™ is for use on the daily
chart interyil, while *1-Midag™ is for use on the intraday chard
imtervals,

The VT Trader code and instructions for creating both
versions of the MIDAS indicator are as follows;

The Midas indicator
1. Navigator WindowsToolsIndicator Builder=[New] bution

3 I the Indicator Bookmark. type the following text for each fiel:

Name: TASC - 08/2008 - Midas

Shorl Mame: vi_Midas.

Label Mask: TASC - 08/2008 - Midas {Starl Date: %em¥/esd%/lesy %)
Placamanl: Price Frama

Inspect Alias; Midas

3. 1y the Lt Bookmark. create the following variables:

[New] button... Mame: sm , Display Nama: Starting Month | Type:
intngar (with bounds) , Dafault: 1, Min Bounds: 1, Max Bounds: 12

(New] button... Name: sd , Display Name: Starting Dy , Type: integar
{with bounds) , Default: 1, Min Bounds: 1, Max Bounds: 31

{New] button... Name: sy , Display Name: Starting Year . Type: intager
(with bounds) , Detault: 2008

4. In the Output Bookmark, create the following varishles:

Mamae: (Midas)

Line Color: dark grasn
Lina Widih: slightly thicker
Line Type: solid

5. In the Formula Bookmark, copy and paste the following formula:

{Provided By: Visual Trading Systems. LLC & Capital Market
Services, {e) Gﬂwﬂfihi )

annﬂpﬂun:'l‘l'm Midas Indicator]

Noles: T.A.S.C., Septamber 2008 - “The Midas Touch” by Andrew
Coles, Fva

[vi_Midas Version 1.0]

itm;ﬁwmwnhu AND sm=Month{) AND sy=Year(};
pvi= MP() * VS

denom:= (l{ValueWhen(1, starl,Cum(V)i=0. 1. Cum(V) -
valusWhen(1,start, Cumi{Vii1

midas:= (Cumipy) - ValugWhen(1,star. Cum{pvi)) / denam;

6. Click the “Save” icon to finish building the Mibas indicator.

To attach the indicator to.a chart (Figure 15), ¢lick the right
mouse button within the chart window and then select “Add
Indicator” -> *TASC - 09/2008 — Midas" from the indicator
lisk.

82 » Septomber 2008 * Technical Analysis of STOCKS & COMMODITIES

%st%Mesy% %sh%:%se%)

[New] button... Name: sm , Display Name: Starting Month . Type:

A T 3.
LT P =
o 2s

FIGURE 15: VT TRADER, THE MIDAS INDICATOR. Heie i the MIDAS indicalor
an & daily charl

|

- e o PR e
FIGURE 16: VT TRADER, THE MIDAS INDICATOR, Hars (s thia MIDAS Indicaior
on & GBPUSD 10-minute candlestick chart

The |-Midas Indicator
|, Navigator Window=>Tools>Indicator Builder=[New] button

2 In the Indicator Bookmark. type the following text for each field:

Name: TASC - 09/2008 - I-Midas
Short Nama: vi_I_Midas
Label Mask: TASC - DE/2008 - 1-Midas (Start Data/Time: Ysms/

Placemant: Price Frame
Inspect Alins: |-Midas

3. In the Input Bookmark, create the following variables:

integer (with bounds) , Detault: 1, Min Bounds: 1, Max Bounds: 12
[mm..mrw.mmﬂmamm.ﬁwwr
{Mﬂxbmmhj.ﬂdauﬂ.mnm:i.uuaﬂumm

[Mew] button... Mams: sy , Display Name; Starting Year | Type: integar
{with bounds) , Default: 2008
[mlw...mﬂ:ﬂ.mmsmw.mhm
cmmbuunm:.mutnumaomn.msnmm

[Mew) button... Name: se , Display Name: Starting Minuts , Type:
integer (with bounds) , Delaul: 0, Min Bounds: 0, Max Bounds: 58

4 In the Dutput Bookmark, ereate the following variahles:




[Misw] butten, ..

Var Nama; |-Midas
Name: (I-Midias)

Line Calor: dark blue

Line Width: slightly thicker
Line Type: solid

5. In the Farmula Bookmark, copy and paste the following formula:

[Pravided By: Visual Trading Systems, LLC & Capital Market
Services, LLC (g) Copyright 2008}

[Dascription: The -Midas Indicator)

[Motes: T.A.S.C., September 2008 - “The Midas Touch” by Andraw
Coles, FhiDj

[vi_I_Midas Viersion 1.0}

start= sd=DayOfMonth() AND sm=Manth() AND sy=Year() AND
sh=Hour() AND se=Minule();

pre=MP() "V

danom:= If(ValueWhen(1.start,Cum(Vij=0, 1, Cum(V) -
ValueWhen(1,start,Cum(V))):

|_midas:= (Cum(pv) - ValueWhen(1 start.Cum(pv])) / denom;

. Click the “Save” jcon to finish hullding the |-Midas mdicator.

To attach the indicator to a chart (Figure 16), click the
right mouse button within the chart window and then select
= Add Indicator™ «> *TASC - 09/2008 - I-Midas" from the
indicaror list.

To learn more about VT Trader. visit www.emsfx.com.

—hrixs Skidmere

Vil Teading Systems, LLC (conrtesy of CMS Forex)
(8a6 1 5 1-CMSFX, trading @ cmyfx.com

W e com

+ INVESTOR/RT: MIDAS INDICATOR

The Investor/RT implementation of the Vwap
cumulative bands indicator provides an option to create
cumulative VWAFP lines originating at any user-specified
dute/time and continuing to the present, as demonstrated in
Figure 17.

The dark blue lines show the cumulative Ywap, while the
light blue lines represent | stundard deviation bands above
and below the Ywap.

These cumulative Ywap lines should be drawn from bars
with extreme highs or lows and provide lines of resisunce
and support, respectively. These lines may be easily dragged
and dropped 1o u new starting dateftime, o they may be
cloned by simply etrl-dragging 1o any bar with an extreme
relative high or low.

Maore information on the Investor/RT implementation of

the Vwar indicator, along with video demonsteations, may
be found m: hitp:Awww linnsoft.com/tourfechind/vwap hitm,
—Chad Payne

Linm Saftware

wiww.linnsoft.com, info@ linnsoft.com
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FIGURE 17: INVESTOR/RT, VOLUME-WEIGHTED AVERAGE PRICE INDICA-
TOR. & dadly chart of tha SAP emini shows cumulstive VIVAR linas from kisy highs
Thes lines are drawn slong with 1 standard deviation bands and can be used for
araas of resistance

Traders.com
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